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Chapter 1. WebSphere Dashboard Framework installation

Follow this information to install or uninstall IBM® WebSphere® Dashboard
Framework.

This product operates as a plug-in to Eclipse-based Integrated Development
Environments (IDEs). If you do not have one of the following supported IDEs, the
installation program will provide Eclipse 3.2:

+ IBM Rational Application Developer 6
+ IBM Rational Software Architect

* IBM Rational Web Developer

* Eclipse 3.1 or 3.2

Prior to installation you must install WebSphere Portal or one of the supported
application servers. Refer to the WebSphere Dashboard Framework Information
Center for more information about supported platforms.

Software requirements

This topic explains the software requirements for installing and using IBM
WebSphere Portlet Factory and IBM WebSphere Dashboard Framework.

Integrated Development Environments (IDEs)

Developing applications with Portlet Factory and WebSphere Dashboard
Framework requires one of the following IDEs, running on Microsoft® Windows®
2000 or Windows XP. If you do not already have an IDE installed, you can opt to
install Eclipse 3.2.1 during installation.

« IBM Rational® Application Developer 6 and 7
+ IBM Rational Software Architect

* IBM Rational Web Developer

* Eclipse 3.1 and 3.2 (SDK versions only)

JDK support

Portlet Factory and WebSphere Dashboard Framework support the following Java
2 SDKs:

e Standard Edition v1.4.1, 1.4.2
Application servers

Before installing Portlet Factory or WebSphere Dashboard Framework, you must
have a Portal server installed and prepared for testing and deploying applications.
In a development environment, the server may reside on your development
machine. In a production environment, the server is usually a remote machine.

For development or production use:

* IBM WebSphere Application Server 5.1, 6.0, and 6.1 (installed with IBM
WebSphere Portal)

* WebSphere Portal 5.1, 5.1.0.2, and 6.0.0.0

© Copyright IBM Corp. 2007 1



* JSR-168 Portal Servers

Note: IBM provides no explicit support for specific JSR-168 portal containers
other than those included with WebSphere Portal.

For development use only:
* Apache Tomcat Server 5.5.x

Server operating systems

Portlet Factory and WebSphere Dashboard Framework applications can be
deployed on application servers running the following operating systems.

IBM AIX®
+ AIX 53

Linux®
* SUSE Linux 9.x
* Red Hat Enterprise Linux AS release 4

Sun Solaris
* Solaris 10 (latest patch level required)

Microsoft Windows

* Windows Server 2000, 2003 (Enterprise or Advanced)
* Windows 2000 Advanced Server SP4

* Windows Advanced Server 2003

Databases

The following databases can be set up for Portlet Factory and WebSphere
Dashboard Framework applications that use relational databases to store data.

DB2°
* DB2 Enterprise Edition 8.1
* DB2 Enterprise Edition 7.2 (FixPack 7 required with db2java.zip)

Oracle
* Oracle 10g
e QOracle 9i Release 2 v9.2.0.1.0

* Oracle 8i Enterprise Release 3 v8.1.7 (requires thin driver for 8.1.7 or
classes12.zip)

Microsoft SQL Server
e MS SQL Server 2000 (requires msbase.jar, mssqlserver.jar, and msutil.jar)

External business software extensions
The following software is required for Portlet Factory and WebSphere Dashboard

Framework applications that use Integration Extensions to connect with these
back-end systems.
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+ IBM Lotus® Domino® v 5.x, 6.0, 6.5, and 7.0 (requires version 6 or later
NCSO jar)

* PeopleSoft 8.x or later, as long as it supports access to Component Interfaces
through the PSJOA jar file (requires PSJOA jar)

* SAP
— SAP R3 v3.1h or later (requires SAPCO jar)
- SAP BW

* Siebel

— Siebel 7.5.2, 7.5.3 (requires Siebel]l jar, Siebel]l_Common.jar, and
Siebel]I_enu.jar files)

— Siebel 7.8 (requires Siebel.jar and Siebel]I_enu jar files)
Client requirements

Clients can use Portlet Factory and WebSphere Dashboard Framework applications
with the following browsers.

* Microsoft Internet Explorer 6.0
* Mozilla Firefox 1.5.0.1
* Netscape Communicator 8.x

Chapter 1. Installation 3
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Chapter 2. Installing and configuring WebSphere Dashboard

Framework

This section describes how to run the installation program and configure your
server to support dashboard applications.

Follow these steps to install and configure IBM WebSphere Dashboard Framework.

Running the installation program

This topic describes how to run the install program to set up your development
environment.

Follow these steps to install Portlet Factory Designer and IBM WebSphere
Dashboard Framework.

1.
2.

© Copyright IBM Corp. 2007

Launch the installation program (install.bat).

In the Language Selection screen, select the language used to display the license
text. Click OK.

Review the Introduction screen, quit any open programs running on the
system, and click Next.

In the License Agreement screen, read the End User License Agreement, select
"I accept the terms of the License Agreement” to proceed with installation.
Click Next.

Note: If you do not accept the license terms, you will be prompted to Quit the
installation.

In the Choose Install Location screen, specify the location where the WebSphere
Dashboard Framework files will be located. The default is C:\Program
Files\IBM\WebSphere Portlet Factory. Click Next.

In the Specify Install Items screen, select an installation choice and click Next.
You can choose one of the following options:

* Into existing IBM Rational Application Developer - Select this option if you
want to continue to use the Rational Development Environment. The
installation program will add menu items specific to the current version of
your Rational Development Environment.

* Into existing Eclipse - Select this option if you want to continue to use the
version of the Eclipse-based IDE already installed. The installation program
adds menu items specific to the current version of your Eclipse IDE. If you
are upgrading, see the note at the end of this topic about upgrading Designer
plug-in files.

* And Eclipse - Select this option if you do not have an IDE. If this option is
selected, the installation program installs Eclipse as the IDE when it installs
WebSphere Dashboard Framework. This option is only visible if there is an
eclipse.zip file in the same directory as the install program.

In the Specify IDE screen, specify the IDE location. Click Next.

Review the Pre-Installation Summary screen. If all information is correct, click
Install.

Alternately, use the Previous button to return to a screen and change a
selection.



9. An Install progress screen is displayed and, once installation is complete, the
Install Complete screen is displayed. Click Done to close the install program.

An install log is created in the install location.

If you have upgraded into an existing Eclipse-based installation, you must update
Designer plug-in files. See "Upgrading plug-in files after installation” for more
information.

Configuring an embedded test server environment

Installing in an embedded test server environment requires a few additional
procedures and steps after installation.

If you are installing on IBM Rational Development Environment Studio
Application Developer in an embedded test environment (application server or
portal server), complete the following procedures.

Turning off validation

Validating all the HTML and XML files in a project can take a long time. You may
want to turn validation off before refreshing your project. This procedure applies to
all projects in the workspace. To disable validation for WebSphere Dashboard
Framework projects only, disable the settings listed below.

Follow these steps to turn off validation.

1. In Rational Developer, select Window - Preferences.

Select Validation and click the Deselect all button.

Click Apply.

In the left pane, select: Web Tools » Links » Validation > Refactoring.
De-select the Enable LinksBuilder check box.

Click Apply.

Click OK to close the Preferences window.

N ook

Configuring the test server

This step publishes the application and starts the test server.
1. Right-click the Web application project and select Run on Server.

2. Select the WebSphere Application Server version and configuration desired,
then click OK. If you have not specified a server configuration, the default
WebSphere Application Server server configuration can be used.

Note: Attaching to a remote server has not been tested.
Modifying the method compiler classPath setting

In order to use builders that utilize code in third-party JAR files, you may need to
change the bowstreet.methods.classPath property in your cluster.properties file.

Follow these steps to change the classPath property

1. Using a text editor, open the project_name/ WebContent /WEB-INF/config/
cluster.properties file.

2. Find the property called bowstreet.methods.classPath.
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3. Append the path to the appropriate j2ee jar file to this property’s value.

For example, to use the j2eel2 jar file that ships with Portlet Factory, use the
following as the value to append to this property: ${ bowstreet.rootDirectory} /
clientLibs /j2eel2.jar . (This file is stored in: bowstreet_root_directory
/WEB-INEFE/ clientlibs )

4. Save and close the cluster.properties file.

5. Restart Rational Application Developer to apply the changes to this property.

Opening and running a model

After you have completed all the preceding steps, you can start using Portlet
Factory to run applications on the embedded test server.

1.

Double-click a model in the WebContent\WEB-INF\models directory to open
the model in Portlet Factory Designer.

2. Choose Run » Run Last Launched or click the "Run” icon in the toolbar to run

the model.

When you run a model, the embedded server you configured is used.

Configuring your environment after installation

Take additional steps to configure your environment after installing IBM
WebSphere Dashboard Framework.

Follow the steps that are appropriate for configuring your server platform.

IBM WebSphere Portal

The following additional configurations are required for WebSphere Portal.

1.

Configure Heap Size -- By default, WebSphere Portal 6 sets 512 MB as the
maximum allowed size for the heap. This maximum should be raised to 1 GB.
If you are using WebSphere Portal 5.x, raise the heap size to 400 MB. Use the
WebSphere Administrative console to set the heap size. For more information
on configuring the heap size, see the WebSphere Administrative Console Help.

Update the Cookie Path - The default settings on the WebSphere Portal do not
include the WebSphere Dashboard Framework root directory in the cookie path.
If you are using a development configuration on WebSphere Portal, the root
directory must be added to the cookie path in order to save your session
information.

You may experience problems with refresh and caching of Web pages before
you update the cookie path. You will not be able to successfully complete the
tutorials without changing the cookie path. Use the WebSphere Administrative
console to replace "/ wps " with "/" in your cookie path.

(WebSphere Portal 5.1 only) Add " pbportlet.jar " File -- This file is needed only
if you plan to build portlets based on the deprecated IBM Portlet API, rather
than the Java Standard API (recommended). This JAR file, included in previous
versions of WebSphere Portal, is not provided with version 5.1 As a result, you
must procure this file and add it to your system. If you have access to a 5.0
version of WebSphere Portal, you can find this file at: WebSphere\PortalServer\
pb\lib. Alternately, you can get a copy of this file from IBM Customer Support.

The default web.xml used to create Factory Portlet WARs includes a reference
to the WebSphere C2A Portlet wrapper (
com.ibm.wps.pb.wrapper.PortletWrapper ). As a result, all Portlet WARs must

Chapter 2. Installing and configuring WebSphere Dashboard Framework 7



include the appropriate version of pbportlet.jar. When developing against
WebSphere Portal 5.1 server, you must manually specify the location of the
directory that contains the pbportlet.jar file.

Once you acquire the pbportletjar file, place it in an accessible directory on the
system on which you are installing WebSphere Portal 5.1.

Create a project and, when the WebSphere Portlet Settings page is displayed,
use the PB Portlet Jar Location input widget and browse to the location of the
pbportlet.jar file. Then select the file and complete project creation.

After you select this file the first time, it will be automatically included in the
portlet WAR created by WebSphere Dashboard Framework.

WebSphere 5.x Application Server

In a WebSphere Application Server 5 environment, you must set the class load
order on the WebApp project so that the class loader for the Factory application
context looks at the JARs in the project’s WebContent/WEB-INF/lib before looking
at those shipped with WebSphere Portal. This ensures that latest versions of
third-party JAR files are correctly picked up.

Follow these steps to set the class load order.

1. In the WebSphere Application Server administrative console, go to
Applications » Enterprise Applications .

2. Click the enterprise application name for your WebSphere Dashboard
Framework installation (for example, "dashboard_framework”) to display a list
of properties for the application.

In the Related Items list of the Configuration Tab, click the Web Modules link.
Click the wpf.war file, displaying the General Properties for the WPF WAR file.
Change the Class loader Mode to " PARENT_LAST " and click OK.

Save the changes to your local configuration.

N oo~

Restart the server.

Apache Tomcat

After creating a new IBM WebSphere Portlet Factory project, restart Tomcat. This
ensures that all libraries are loaded correctly.

Setting up native language support

To set up a language other than English, install the Eclipse language pack.

WebSphere Dashboard Framework supports Group 1 languages, namely German,
Spanish, French, Italian, Japanese, Korean, Portuguese (Brazil), Traditional Chinese,
and Simplified Chinese. To use a language other than English, you must download
a language pack from the Eclipse Web site and install that pack into your Eclipse
IDE.

Follow these steps to enable language support.

1. Verify that Microsoft Windows is configured to use a non-English, Group 1,
language.

2. Exit Portlet Factory Designer.

3. Access the Eclipse.org Web site home page and navigate to: Downloads | All
Versions | 3.2 Language Packs.
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4. In the Language Packs: 3.2 screen, download the NL-1 pack zip files for the
Microsoft Windows platform. (Two zip files are required.)

5. Extract these zip files into your Eclipse installation, making sure to do so at
the correct directory level.

6. Start Portlet Factory Designer.

Eclipse runs in the language configured on the Windows machine.

Note: You can force Eclipse to run in another language by adding a language
identifier to the Eclipse startup command. For example, by adding:
-Duser.language=es -Duser.country=ES to the startup command, you can
run Eclipse in Spanish, regardless of the language the system is
configured to use.

Chapter 2. Installing and configuring WebSphere Dashboard Framework 9
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Chapter 3. Creating a project after installation

Run IBM WebSphere Portlet Factory Designer to access WebSphere Dashboard
Framework features.

To complete configuration tasks for WebSphere Dashboard Framework, you will
need to create a project first.

1. Start Designer by choosing Start » Programs » IBM WebSphere > Portlet
Factory » Designer.

2. When starting up Rational Development Environment Studio, you are
prompted for a workspace location.

If you will be running applications on your local machine (which is called an
embedded test server environment), specify a workspace location close to the
root directory to prevent path and file names from exceeding the 256-character
limit imposed by Microsoft Windows; for example, c:\factory\my_projects\.

3. Open the WebSphere Dashboard Framework Getting Started Guide by Start »
Programs > IBM WebSphere » Dashboard Framework » Getting Started
Guide. You need Adobe Acrobat Reader to open this PDF file.

4. Follow the instructions in the Getting Started Guide for creating a project.
This information is also available in the Getting Started section of Help.

Using Help

WebSphere Dashboard Framework and Portlet Factory both come with
Eclipse-based Help, which you can open from the Help menu of your IDE. Help is
also available by pressing F1 or clicking the Help button from dialog boxes and
development windows. To find additional documentation on the IBM Web site,
choose Start » Programs > IBM WebSphere > Dashboard Framework » Online
Documentation

© Copyright IBM Corp. 2007 11
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Chapter 4. Upgrading plug-in files, projects, and portlets

After installation, take additional steps to upgrade existing applications.

This section explains how to upgrade the product’s plug-in files, existing projects,
and portlets.

Upgrading plug-in files after installation

After upgrading WebSphere Dashboard Framework or WebSphere Portlet Factory
into an existing Eclipse-based system, you must replace old Designer plug-in files
with newer versions.

Follow these steps to update the Designer plug-in files:
1. ClickStart » Programs » IBM WebSphere > Portlet Factory > Designer.
2. Choose Help ~» Software Updates » Manage Configuration.

3. In the left pane of the Project Configuration window, right-click the old
installation and choose "Disable.”

This disables the old versions of the plug-in files.
4. Restart Portlet Factory Designer.
The new plug-in files will be used.

Note: If you receive an error during project creation indicating that the system
cannot find the file specified, start Eclipse using the -clean flag. This clears
out persisting parameters that were set in Eclipse before you upgraded. See
the Eclipse documentation for additional details about the -clean option.

Now upgrade existing projects to use new Designer components, as described in
"Upgrading projects.”

Upgrading projects

After you install and upgrade plug-ins, upgrade existing projects to use the new
plug-in files.

Follow these steps to upgrade a project to incorporate the newest IBM WebSphere
Portlet Factory plug-in files.

1. In Portlet Factory Designer, open the project to be upgraded.

2. Right-click the project in the Navigator and select WebSphere Portlet Factory
+» Upgrade Project Version.

3. When prompted, click OK.
The project will be updated to use the latest components.

4. For the deployed applications to use the new versions of the files, you will
need to cycle the server after you update the project.

Upgrading portlets to the Java Standard Portlet API

Upgrade portlets built using the deprecated IBM Portlet API to the new Java
Standard Portlet API.

© Copyright IBM Corp. 2007 13



Starting with IBM WebSphere Portal 6, there is a new Java Standard Portlet API for
portlets. While portlets designed for use in previous versions of WebSphere Portal,
and built using the now deprecated IBM Portlet API, will continue to run in
WebSphere Portal 6, it is recommended that any new portlets be built using the
Java Standard Portlet API. The new standard allows developers to create portlets
that work across multiple portal servers without requiring code changes.

Follow these steps to upgrade a portlet built in a previous version of Portlet
Factory to use the new Java Standard APIL

1. In Portlet Factory Designer, open the project containing the portlet model.

2. Right-click the project in the Navigator and choose WebSphere Portlet Factory
Project » Upgrade Project Version.

3. Use the Auto-Deploy function to deploy the updated portlet WAR file to
WebSphere Portal.

4. Use the WebSphere Administration tool to place the updated portlets on Portal
pages.
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Chapter 5. Removing IBM WebSphere Dashboard Framework

To remove the product, uninstall the product and remove project WAR files.

Follow these steps to remove IBM WebSphere Dashboard Framework files and
project WAR files.

1.
2.
3.

© Copyright IBM Corp. 2007

Use the Windows Control panel to access the Add/Remove Programs tool.
Select IBM WebSphere Dashboard Framework and click Change/Remove.
When the Uninstall screen appears, click Uninstall.

Product files, registry entries and shortcuts are removed from your system.

Use your application and portal server administration tools to remove
installable and installed WAR files.

If necessary, delete from the server’s file system any remaining application- or
portlet-related directories and files.
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Office 4360

One Rogers Street
Cambridge, MA 02142
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

Supplemental Copyrights and Acknowledgments

The following Copyrights and Acknowledgments apply to various software
components included in IBM WebSphere Portlet Factory, but neither created nor
owned by IBM.

This offering is based on technology from the Eclipse Project (http://
www.eclipse.org/).

This product includes software developed by the Apache Software Foundation
(http:/ /www.apache.org).

Portions of this software provided by JDOM. Copyright (C) 2001 Brett McLaughlin
& Jason Hunter. All rights reserved. Portions of this software provided by the
membership of the XML-DEV mailing list. You can obtain a copy of the SAX
copyright status at http:// www.megginson.com /SAX/.

Trademarks

The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both:

IBM

Lotus
WebSphere
Workplace
Portlet Factory

Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.
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Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of
others.
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